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Inmarsat B



Vox Maris
GMDSS Simulator

Vox Maris is a technical training tool. It is a PC-based simulator to train sea-faring
people in the use of GMDSS communications equipment, within a controlled and
safe environment. 

Vox Maris simulates the functionality of marine radio and satellite communications
equipment according to the operational norms determined by The International
Telecommunication Union. It also emulates real conditions of the marine radio
communications such as noises, attenuation by distance in terrestrial and
ionospheric propagation, and different types of sound effects from communication.
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1 Introduction

Inmarsat Network

With  the  purpose  of  providing  global  communications  for  ships,  land  mobile  and
aircraft, using satellites to overcome the problems that exist with conventional radio
communications, the Inmarsat operates a network consisting  of  the  space  segment,
ground segment and mobile earth stations.

The Inmarsat space segment consists of 4 satellites orbiting above the equator at the
same speed as the earth rotates. The satellites remain fixed above the same location
on the earth. Each satellite orbits at an altitude of 35,700 km, allowing it to monitor
1/3 of the earth’s surface. The satellites work as repeater stations between the coast
earth  stations  (CESs)  and  mobile  earth  stations  (MESs)  on  different  channels  for
different services, Inmarsat-A, B, C and M, FleetNet.

Inmarsat B - Features

The Inmarsat-B  maritime  satellite  communication  system  provides  digital  telephone
(voice),  facsimile,  telex  and  data  (9600  kbps)  and  HSD  services.  Use  of  the  latest
digital  technology  means  lower  toll  charges  than  in  Inmarsat-A,  since  high  output
power satellites are not required and data is transmitted at high speed.

Inmarsat-B  covers  the  communication  requirements  of  GMDSS  system,  since  its
stations  are  equipped  with  means  to  emit  distress  alerts  in  emergency  cases.  In
stations  with  Telex,  the  distress  calling  includes,  automatically,  information  about
position,  time,  distress  priority,  and  other  useful  data  for  the  land-based  rescue
co-ordination centre (RCC).
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Inmarsat Coverage map

 

There  are  four  Ocean  Regions  covering  the  world  each  with  its  own  operational
satellite.

Atlantic Ocean Region East (AOR-E), Inmarsat-3 F4 satellite at 54,0º W 
Atlantic Ocean Region West (AOR-W), Inmarsat-3 F2 satellite at 15,5º W 
Indian Ocean Region (IOR), Inmarsat-3 F3 satellite at 178,0º E
Pacific Ocean Region (POR), Inmarsat-3 F1 satellite at 64,0º E

The Inmarsat system consists of the Operation Control Center (OCC), Satellite Control
Centers (SCC), four Network Coordination Stations (NCS) (one for each ocean region),
Land  Earth  Stations  (LES)  and  Mobile  Earth  Stations  (MES).  The  OCC,  located  at
Inmarsat's  London  headquarters,  coordinates  a  wide  range  of  activities  in  the
Inmarsat system, including commissioning of mobile earth stations.

Transmission  and  reception  of  signals  are  co-ordinated  by  network  co-ordination
stations  (NCS).  Each  NCS  monitors  the  flow  of  communications  traffic  through  its
satellite  to  ensure  that  calls  are  correctly  set-up  and  that  all  LESs  are  working
correctly.
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Types of MES

There  are  two  types  of  MES:  class  1  (provides  telephone  and  telex  services,  and
satisfies GMDSS requirements) and  class 2 (consists of only the components required for
telephone services.).

   NOTE: Vox Maris simulates Class 1 equipments.



Station components

Chapter II
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2 Station components

 

An  Inmarsat-B  station  (class  1)  provides  telephone,  telex,  facsimile  and  data
transmission  services.  The  equipment  is  made  up  of  a  Main  Communication  Unit
(MCU),  which  is  the  central  component.  At  the  MCU  connects  the  Antenna,  the
Handset (telephone) and the Telex terminal (only for class 1)



Station components 7

© 2009    Advenio Software S.R.L.

2.1 Handset

Handset controls

2.2 Telex terminal

Keyboard
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The terminal is controlled from the keyboard. The most important are Esc keys and
function keys. The other keys work similarly to those of any other keyboard.

Esc: Cancels current action and returns to previous screen.

F1: File Menu - (files processing)
F2: Edit Menu - (editing text features)
F3: Telex Menu - (messages transmission)
F4: Setup Menu - (terminal configuration)
F5: WRU -  Who Are You:  Requests  to  the  other  station  in  communication
that send their identification.
F6: HRIS  -  Here  is:  Sends  own  identification  to  the  other  station  in
communication.
F7: Bell - (Not implemented)
F8: Window -  Switch between Stand-By  /  File  Area  /  Communication  area
windows.
F9: AlmRst - Alarm Reset: Mutes the sound signal activated when receiving
a Telex message.
F12: Break - Finish current communication.

Work areas

The terminal screen is in one of the 3 following areas:

- Stand-By
- File Area
- Communication Area

Stand-By

The system remains in this screen when the station is not in a Telex communication
or editing a file. Displays information about the general state of the station.
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File Area or Edit Area

The system remains in this screen when a file is is being edited.

Communication Area

The  system  remains  in  this  screen  when  the  station  is  in  the  course  of  a  Telex
communication, or when is reviewing the contents of a previous communication.
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During  a  manual  communication,  the  text  typed  in  the  communication  area  will  be
transmitted automatically to the receiving station.

2.3 System On/Off

When the  communication  unit  is  powered  it  supplies  power  to  the  handset  and  the
antenna unit. If a navigator are connected, the antenna unit is
automatically  oriented  towards  the  satellite  selected.  Several  minutes  later  the
satellite is “acquired” and the system goes into Stand-By, awaiting
communications.

The Terminal unit turns On / Off from a self-control: 

Following, the Stand-By displays for the Terminal unit and Handset:
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When READY is displayed on the Terminal unit and Handset the following actions can
be done:

Handset, telephone communications:

· When  the  handset  rings,  pick  it  up  and  press  the  [Hook  Off]   key  to

communicate with party station.
· Dial subscriber’s number (LES, subscriber’s number or ship ID) to communicate.

Terminal, Telex communications:

· Receive and read a telex message.

· Send a telex message.



Handset communications

Chapter III
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3 Handset communications

This  chapter  covers  handset  communications.  The  handset  functions  to  make  voice
calls to shore and other ships. It also functions to set up the Class 1 system.

3.1 Stand-By display

The  Stand-By  display  appears  about  three  seconds  after  turning  on  the
communication unit. This is where you begin all handset operations.

3.2 Calling

The  Inmarsat-B  system  provides  telephone  services  for  both  land  and  maritime
subscribers.

General calling procedure

1.Confirm  that  the  signal  strength  indicator  is  showing  at  least  2  periods  and  the
indication READY is displayed.

2.Pick up the handset and press the [Hook Off] key 

The Dial display appears
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Dialing procedure for calling land subscriber

Enter the number to call respecting the following structure (there is a maximum of
30 seconds to enter the number, otherwise automatically revert to the Stand-By
display)

* __ __ __  * *  __ __     __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __
#

 LES Number      Service             Country Code and Subscriber’s number          
End 
                        Code 

  
    * : Separator (switch to access code mode)

  LES Number: see LES Access Code List

  * *: Separator (switch to number mode)

  Service Code: 
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  Country Code: see Telephone, Telex Country Code Lists

  #: End of number. Starts calling to the subscriber entered. That can be done also
by pressing [Hook Off] key.

Notes:
   - If the LES number is not entered, the communication is done using the LES

selected by default.

   - The system warns if the LES number or subscriber are invalid.

Dialing procedure for calling MES

Enter the number to call respecting the following structure (there is a maximum of
30 seconds to enter the number, otherwise automatically revert to the Stand-By
display)

*  __  __  __  * *  __  __     __  __  __    __  __  __  __  __  __  __  __  __  #

       LES Number       Service         Sea                  Ship/Station                   End 
                              Code            Area                  ID number

  * : Separator (switch to access code mode)

  LES Number: see LES Access Code List

  * *: Separator (switch to number mode)

  Service Code: 

  Sea Area: 
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  #: End of number. Starts calling to the subscriber entered. That can be done also
by pressing [Hook Off] key.

Notes:
   - If the LES number is not entered, the communication is done using the LES

selected by default.

   - The system warns if the LES number or subscriber are invalid.

3.The Call display appears during calling:

 

4. When subscriber answers begin communications.

5. You may adjust the volume of the handset speaker by pressing the arrows keys.
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6. Press the [Hook On] key to finish communications.

7. Hang up the handset. The Stand-By display appears after few seconds.

3.3 Redialing

The redial feature automatically redials a previously dialed telephone number.

1.  Confirm  that  the  signal  strength  indicator  is  showing  at  least  2  periods  and  the
indication READY is displayed.

2. Press the [REDIAL] key. The display should look something like the one below. 
    If there are no numbers stored only the message “No Data”  appears.

     à        

3. Select redial number using the arrows keys

4. Press the [Hook Off] key to redial number selected.
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3.4 Receiving

Receiving  a  telephone  call  in  the  Inmarsat  system  is  exactly  the  same  as  with  a
conventional telephone: simply pick up the handset, press the Hook Off key and listen
to  the  party.  When  a  call  is  received  the  handset  rings  and  the  display  looks
something like the one below.

1. Pick up the handset.

2. Press the [Hook Off] key to begin communication.

3. Press the [Hook On] key to disconnect the line.

 

4. Hang up the handset.

NOTE:  the  tone  sounds  in  the  handset  according  to  call  priority.  Is  different
depending on whether a call routine, a distress, safety or urgent call.

3.5 Urgent/Safety communications

Urgent  or  safety  communications  are  possible  by  setting  priority  before  calling.  The
priority automatically becomes ROUTINE after completion of call.

Safety communicates important meteorological or navigation warning.

Urgent communicates safety of ship or safety of person.

1.  Confirm  that  the  signal  strength  indicator  is  showing  at  least  2  periods  and  the
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indication READY is displayed.

2. Pick up the handset and press the [Hook Off] key

3.  Press  the  [DEL  Prty]  key  to  select  priority  desired.  Each  pressing  of  the  key
selects priority in the sequence shown below.

4. Dial LES in 3 digits and press (eg: 012) and press the [# Ent] key.

NOTE:  LES  by  default  is  automatically  called  if  the  [#  Ent]  is  pressed  without
enter any LES number.

5. Communicate with LES.

6. Press the [Hook On] key to finish communications.

7. Hang up the handset. The Stand-By display appears after few seconds.
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3.6 Distress communications

Transmit the Distress alert only in a life endangering situation or when the ship need
immediate help. 

The [Distress]  button is found at the rear of the handset. The procedure for issuing
distress alert is as follows:

1. Pick up the handset.

2. Open the distress button cover.

   ð  

3.  Press  and  hold  down  the  [DISTRESS]  button  6  seconds.  The  unit  beeps
intermittently  and  the  red  lamp  on  the  button  flashes.  After  the  6  seconds,  the
priority automatically becomes "DISTRESS" and appears the following display:

4. Dial LES in 3 digits and press (eg: 012) and press the [# Ent] key.

NOTE: LES designated on the SETUP - Distress LES menu (see Handset  Menus)
for the current ocean region,  is  automatically  called  if  simply  press  the  [# Ent]
key without enter any LES number, or there is no key input within 30 seconds.

5. Commence communication with LES, giving  your  ship’s  name,  nature  of  distress,
assistance needed and description of your vessel.
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6. Press the [Hook On] key to to finish communications.

7. Hang up the handset. The Stand-By display appears after few seconds. The priority
returns to ROUTINE (Normal).

3.7 Menus

The menus provides access to Display, Setup and Test functions of the handset. The
menus  are  opened  /  closed  using  the  [FUNC Quit]  key,  the  options  are  navigated
using [Up] and [Down] keys, and an option is selected pressing [# Ent] the key.
were sailing through the keys up / down and select one with the key [# Ent]:

               
[FUNC Quit]  Up / Down [# Ent]

3.7.1 Main menu

From Stand-By display, press the [FUNC Quit] key to display the MAIN MENU

 

DISPLAY:  allows  access  to  the  system  status  (MONITOR)  and  the
Communication LOG.

SETUP: allows access to equipment configuration.

ADDRESS BOOK: allows access to the Stations address book. Lets make calling
selecting a station from the list.

TEST: test the [DISTRESS] button of the handset. 
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3.7.1.1 DISPLAY Menu

Select the DISPLAY option from MAIN MENU and press the [# Ent] key. 

This opens the following menu

MONITOR: displays system status.

COMM. LOG: displays Communications LOG.

3.7.1.1.1  MONITOR Menu

Select the MONITOR option from DISPLAY menu and press the [# Ent] key. 

Navigate the options and screens using the [Up] and [Down] keys. Press the [FUNC
Quit] to return to previous menu.
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3.7.1.1.2  Communications Log

Select the COMM. LOG option from DISPLAY menu and press the [# Ent] key.

It  access  the  communications  log,  from  the  oldest  to  the  newest.  Navigate  the
communications list using the [Up] and [Down] keys.
The following are examples of communications:

Communication No.: 1 of 5
Role: T - Transmit
Date/Time: 04/26/2008 18:55:55
Comm. Time: 19 seconds
Priority: Normal
Satellite: AOR-W
Comm.Mode: Handset (HSET)
LES: 021
Subscriber No: 874 300701000

Communication No.: 2 of 6
Role: T - Transmit
Date/Time: 04/26/2008 18:56:52
Comm. Time: 13 seconds
Priority: Distress
Satellite: AOR-W
Comm.Mode: Handset (HSET)
LES: 021
Subscriber No: LES 021
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Communication No.: 3 of 6
Role: T - Transmit
Date/Time: 04/26/2008 19:01:05
Comm. Time: 24 seconds
Priority: Safety
Satellite: AOR-W
Comm.Mode: Handset (HSET)
LES: 021
Subscriber No: LES 21

Communication No.: 5 of 6
Role: T - Transmit
Date/Time: 04/26/2008 19:02:55
Comm. Time: 25 seconds
Priority: Urgency
Satellite: AOR-W
Comm.Mode: Handset (HSET)
LES: 003
Subscriber No: LES 003

Communication No.: 7 of 7
Role: R - Receive
Date/Time: 04/26/2008 19:26:40
Comm. Time: 25 seconds
Priority: Normal
Satellite: 584 (AOR-W)
Comm.Mode: TELEX
LES: 021
Transmitter: 300701000

IMPORTANT:  Log  shows  communications  made  via  Handset  as  communications
made by Telex.

NOTE: If there were no communications, the following screen appears:
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3.7.1.2 SETUP Menu

Select the SETUP option from MAIN MENU and press the [# Ent] key.

This opens the following menu:

Satellite: If  the station is in a region where  coverage overlaps,  can select  the
satellite manually.

Position: When the equipment is not connected to a GPS navigator,  can enter
latitude and longitude position manually.

Area: allows select Navarea(s) from which to automatically receive information,
for example, weather broadcasts.

Distress  LES:  allows  select  the  LES  by  default  (for  each  ocean  region)  where
the ship will transmit the distress signal.

DMG: allows specify nature of distress.

3.7.1.2.1  Distress LES

Allows  select  the  LES  where  the  ship  will  transmit  the  distress  signal.  Select  the
Distress LES option from SETUP menu and press the [# Ent] key.
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This opens the Distress LES menu showing, for each ocean region, the LES to which
transmit the distress signal.

1. Select an Ocean Region. For example, AOR-E.

2. Key in LES to use (in three digits) and press the [# Ent] key.

3. Repeat steps 1 and 2 to enter distress LES for other regions.

4. Press the [FUNC Quit] key several times to close the menu.

3.7.1.2.2  DMG

This  option  allows  modify  information  to  be  sent  in  a  Distress  message.  Select  the
DMG option from SETUP menu and press the [# Ent] key. 

It shows the following screen:
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When  circumstances  permit,  must  be  chosen  the  option  of  Distress  Nature.  The
following information is displayed.

      

Using the [Up] and [Down] keys, select the distress nature and press the [# Ent] to
confirm the selection followed by the [FUNC Quit] to return to previous menu.

3.7.1.3 Address Book

The  Address  Book  is  an  agenda  Stations  registered.  Lets  make  callings  selecting  a
station from the list.

To access the stations list , select the ADDRESS BOOK option from MAIN MENU and
press the [# Ent] key. 

It opens a similar screen to the following:



Vox Maris GMDSS - Inmarsat B28

© 2009    Advenio Software S.R.L.

Shows  the  station  name  and  the  station  number  (the  first  3  digits  are  the  ocean
region).  Navigate  the  stations  list  using  the  [Up]  and  [Down]  keys,  and  press  the
[Hook Off] key to call the selected station.

3.7.1.4 Testing Distress button

The test of the [DISTRESS] button of the handset, checks the proper operation of this
button.

Select the TEST option from MAIN MENU and press the [# Ent] key. 

It shows the following screen:

Press the [FUNC Quit] to cancel the Test and return to previous menu.

Press the [# Ent] to begin the Test:
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VERY IMPORTANT: The distress test is automatically cancelled after 30 seconds. For
this reason complete the next steps within 30 seconds.

1. Pick up the handset.

2. Open the distress button cover on the hanger.

   ð  

3. Press and hold down the [DISTRESS] button by 6 seconds. Unlike a real distress
situation, in this case the red light of the button is not flashing and not broadcast any
audio signal. After the 6 seconds, the next screen appears, where in the second line is
displayed that is a Test Distress.

4.   Key  in  LES  number  (use  3  digits,  eg.  012)  and  press  the  [#  Ent]  key  or  the
[Hook Off] key.

NOTE:  LES  by  default  is  automatically  called  if  the  [#  Ent]  is  pressed  without
enter any LES number.
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5.  Wait  for  few seconds.  Press  the  [Hook On]  key  when  it  begins  to  hear  a  guide
indicating that the test was successful.

6. Hang up the handset. The priority returns to ROUTINE (Normal).



TELEX terminal communications

Chapter IV
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4 TELEX terminal communications

This  chapter  covers  communications  with  Telex  Terminal.  A  telex  message  may  be
sent in 2 ways:

· Auto Telex

· Manual Telex 

Telex  messages  may  be  stored  on  floppy  disks.  The  messages  to  send  can  be
retrieved from a floppy disk, or handwritten and sent without saving / recovering.

Terminal components

Keyboard
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The terminal is controlled from the keyboard. The most important are Esc keys and
function keys. The other keys work similarly to those of any other keyboard.

Esc: Cancels current action and returns to previous screen.

F1: File Menu - (files processing)
F2: Edit Menu - (editing text features)
F3: Telex Menu - (messages transmission)
F4: Setup Menu - (terminal configuration)
F5: WRU -  Who Are You:  Requests  to  the  other  station  in  communication
that send their identification.
F6: HRIS  -  Here  is:  Sends  own  identification  to  the  other  station  in
communication.
F7: Bell - (Not implemented)
F8: Window -  Switch between Stand-By  /  File  Area  /  Communication  area
windows.
F9: AlmRst - Alarm Reset: Mutes the sound signal activated when receiving
a Telex message.
F12: Break - Finish current communication.

Work areas

The terminal screen is in one of the 3 following areas:

- Stand-By
- File Area
- Communication Area

Stand-By

The system remains in this screen when the station is not in a Telex communication
or editing a file. Displays information about the general state of the station.
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File Area or Edit Area

The system remains in this screen when a file is is being edited.

Communication Area

The  system  remains  in  this  screen  when  the  station  is  in  the  course  of  a  Telex
communication, or when is reviewing the contents of a previous communication.
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During  a  manual  communication,  the  text  typed  in  the  communication  area  will  be
transmitted automatically to the receiving station.

4.1 Transmission

4.1.1 Automatic Telex

A  telex  message  is  automatically  sent  using  pre-registered  LES,  station  and
subscriber  number.  Answerback codes  are  automatically  exchanged  between  sender
and receiver.

There are two ways to prepare a telex message for automatic transmission:

a) Select message from floppy disk
b) Prepare message on the file area

Detailed procedure

1.  At  the  Stand-By  display  (or  File  area),  press  [F3]  to  open  the  Telex  menu  and
then select the Auto Telex option.
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It shown the Auto Telex display:

2. In the Station / Telex N° line press the [Enter] key to open the Station List.
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   Operate the arrow keys to select the desired station and press the [Enter] key.

3. The LES Access Code line shows the LES through which communication is carried
out (automatically shows the LES by default).

    Press the [Enter] key to open the LES List if it want to change the LES.

    Operate the arrow keys to select the desired option and press the [Enter] key.

4. If it want to send the message currently displayed on the File area go to step 5. To
send a file stored on a floppy disk, insert appropriate floppy disk in the disk drive on
the terminal unit and press [Enter] in the File to Send line.
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 à [Enter] à

   Operate the arrow keys to select a file and press the [Enter] key.

5. In the Transmit line, press the [Enter] key to begin the transmission.

 à [Enter] à

     
      

Press  the  [Enter]  key on  Send  option  to  send  the  message,  or  select  Cancel  and
press the [Enter] key to cancel the transmission.

6.  When  select  Send,  it  is  automatically  connected  to  the  LES  selected  and  the
message is sent to station selected. After  the  message  is  transmitted,  the  line with
the  LES  is  automatically  disconnected.  If  5  periods  are  typed  at  the  end  of  the
message, notice of call duration appears prior to disconnection of the line:
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4.1.2 Manual Telex

To transmit  a telex message manually, the  operator  selects  station,  LES,  subscriber
number, and manually transmits answerback code. This can be done:

- Using menus
- Manually, entering commands by keyboard

4.1.2.1 Using Menus

1.  Verify  the  communication  line  is  available  (READY),  not  in  the  course  of  a
communication.  Press  [F3]  to  open  the  Telex  menu  and  then  select  the  Call  LES
option.
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It shown the display to specify the LES:

2. The LES Access Code line shows the LES through which communication is carried
out (automatically shows the LES by default).
    Press the [Enter] key to open the LES List if it want to change the LES.

    Operate the arrow keys to select the desired option and press the [Enter] key.

3. Press the [Enter] key on Priority line, if it want to change the priority.



TELEX terminal communications 41

© 2009    Advenio Software S.R.L.

    Operate the arrow keys to select the desired option and press the [Enter] key.

4. Press the [Enter] key on Service Code line, if it want to change the service code.
    Note: The simulator only implements the service code 00. 
 
5. Press the [Enter] key on Connect line, to begin the connection with the LES.

  à [Enter] à

   Press the [Enter] key on Send option to connect with LES, or select  Cancel  and
press the [Enter] key to return to previous step.      

6.  When  select  Send,  “GA+”  (Go  Ahead),  should  be  displayed,  meaning  that  the
connection with LES selected has occurred. The "CONNECT TO LES" message appears
in the notification area (in the second line on the far right).
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7.  Once  established  connection  with  the  LES,  it  has  20  seconds  to  call  a  station.
Otherwise,  the  line  with  the  LES  is  disconnected  and  the  terminal  return  to  the
Stand-By display.

To call a station, press [F3] to open the Telex menu and then select the Call Station
option.

It shown the display with the registered Station List:
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 Operate the arrow keys to select the desired option and press the [Enter] key. The
following information appears:

The  "CONNECT"  message  appears  in  the  notification  area  indicating  that  it  is
connected to a station.

After other station's Answerback code appears on the display, press the [F6 - HRIS]
key to send the own ship's Answerback code.

At  the  moment  everything  typed  in  the  communication  area  will  be  transmitted
automatically to the other station. Similarly, everything that the operator of the other
station enter by keyboard in its communication area, appears in the terminal itself.
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8. Also it may send the contents of a file previously stored on a diskette. To do this,
insert the appropriate diskette, press [F3] to open the Telex  menu and then select
the File Transmit option.

Pressing [Enter] it opens the list to select a file:

   Operate the arrow keys to select the desired option and press the [Enter] key.

   The  (Transmitting  File  xxxx...)  message  appears  in  the  communication  area  and
after this, the contents of that file.

9.  Pressing  [  F12  ]  disconnects  the  line.  Ending  Telex  CALL...  appears  in  the
communication area for few seconds.

The system returns to Stand-By mode.
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4.1.2.2 Manually

1.  Verify  the  communication  line  is  available  (READY),  not  in  the  course  of  a
communication.  Press  [F8]  successively  until  reach  the  communication  area
window.

2. Key in the LES to use for the communication (in three digits) followed by "+" sign
to accept the code, and press the [Enter] key.

3.  “GA+”  (Go  Ahead),  should  be  displayed,  meaning  that  the  connection  with  LES
selected has occurred. The "CONNECT TO LES" message appears in the notification
area (in the second line on the far right):

4.  Once  established  connection  with  the  LES,  it  has  20  seconds  to  call  a  station.
Otherwise,  the  line  with  the  LES  is  disconnected  and  the  terminal  return  to  the
Stand-By display.

    Key  in  the  Service  Code  to  use  (00),  the  ocean  region  code  or  country  code  in
which  it  is  the  called  station,  and  station  to  call  number   followed  by  the  "+"  sign.
Press the [Enter] key. The following information appears:
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The  "CONNECT"  message  appears  in  the  notification  area  indicating  that  it  is
connected to a station.

After other station's Answerback code appears on the display, press the [F6 - HRIS]
key to send the own ship's Answerback code.

At  the  moment  everything  typed  in  the  communication  area  will  be  transmitted
automatically to the other station. Similarly, everything that the operator of the other
station enter by keyboard in its communication area, appears in the terminal itself.

5. Also it may send the contents of a file previously stored on a diskette. To do this,
insert the appropriate diskette, press [F3] to open the Telex  menu and then select
the File Transmit option.

Pressing [Enter] it opens the list to select a file:
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   Operate the arrow keys to select the desired option and press the [Enter] key.

   The  (Transmitting  File  xxxx...)  message  appears  in  the  communication  area  and
after this, the contents of that file.

6.  Pressing  [  F12  ]  disconnects  the  line.  Ending  Telex  CALL...  appears  in  the
communication area for few seconds.

The system returns to Stand-By mode.

4.1.3 Distress communications

Transmit the Distress alert only in a life endangering situation or when the ship need
immediate help. 

The  [Distress]   button  is  found  at  forefront  of  the  Terminal.  The  procedure  for
issuing distress alert is as follows:

1. Open the distress button cover.
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   ð  

2.  Press  and  hold  down  the  [DISTRESS]  button  6  seconds.  The  unit  beeps
intermittently  and the red lamp on the button  flashes.  The Distress  in  progress...
message appears in the notification area.

3. After  the 6 seconds, a communication with  DISTRESS  priority  is  established with
the LES designated on the SETUP menu, Distress LES (see Handset Menus) for the
current  ocean  region.  When  the  message  is  recognized  by  the  Rescue  Coordinating
Center (RCC), the DISTRESS MESSAGE CALL ACKNOWLEDGED  appears on a red
background in the Distress area (second line):

4. GA+ indicates that the LES station is awaiting a message. If there is no pressure
by time and circumstances permit, a telex communication can be typed directly from
the keyboard.

5. Pressing [ F12 ] disconnects the line.

6. The Stand-By display appears after few seconds. The priority returns to ROUTINE
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(Normal).

4.2 Routine Communications reception

When it receives a routine telex message a audible alarm sounds. In the notification
area the "INCOMING TELEX" message appears followed by Normal priority. 

Silence the alarm by pressing [F9] AlmRst. and access to the Communication area.
The CONNECT  message  is  displayed in  the  notification area.  In  the  communication
area it  shows the starting  time  of  the  communication,  the  LES number  through  the
connection is made, the Answerback Code of both stations, own and the station that
called:

At  the  moment  everything  typed  in  the  communication  area  will  be  transmitted
automatically to the other station. Similarly, everything that the operator of the other
station enter by keyboard in its communication area, appears in the terminal itself.

Also it may send files as explained in Automatic Telex communication.

Pressing [F12] disconnects the line.
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4.3 Communications Log

Press [F3] to open the Telex menu and then select the Communication Log option.
Press the [Enter] key.

It shown the Communication Log:

 

Each line displays the data of one communication:

Role: T - Transmit / R - Receive
OR:  Ocean Region / Country Code
LES: LES used in the connection
Destination: Telex number of the party station
Prty: Priority
Type: Communication mode: HSET(handset) / TELEX
Date/Time: 04/26/2008 18:55:55
Communication time: 19 seconds

IMPORTANT:  Log  shows  communications  made  via  Handset  as  communications
made by Telex.
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4.4 Testing Distress button

The test of the [DISTRESS] button of the Telex terminal, checks the proper operation
of this button.

Select the Test Distress from the TELEX menu. 

Pressing the [Enter] key, the following window appears:

Press the [Enter] key on Cancel option to cancel the Test and return to the previous
menu.

Press the [Enter] key on Start option to start the Test.

VERY IMPORTANT: The distress test is automatically cancelled after 30 seconds. To
avoid sending a distress signal  wrongly,  it  must  complete  the  following steps  within
less than 30 seconds (in brackets show the seconds remaining to complete the test).

Open the distress button cover.
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Press  and  hold  down  the  [DISTRESS]  button  by  6  seconds.  Unlike  a  real  distress
situation, in this case the red light of the button is not flashing and not broadcast any
audio signal. After the 6 seconds, a Test message is send to the LES by default:

If the message is properly recognized by the LES, the test is considered successful.

The priority returns to ROUTINE (Normal).



File operations

Chapter V
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5 File operations

This chapter describes how to create,  save and edit  files.  These features are mainly
centralized in the File menu. The Edit menu provides a full lineup of editing facilities
including search and replace.

5.1 Creating Files

1. Press [F1] to open the File menu and then select the New Text option.

2. It actives the file area. The new file, appears empty and unnamed (NONAME.TXT
). The name will be asked when the file is saved.

Note: whether to create a file, there is another file in the editing area, it will close. If that file
has  been  modified,  and  its  changes  have  not  been  saved,  will  be  asked  to  confirm  the  file
name.

5.2 Saving a File

Before save a file to a floppy disk, the disk must be formatted (see Formatting Floppy
disks).

1.  Press  [F1]  to  open  the  File  menu  and  then  select  the  Save  Text  option.  The
following window appears:
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Enter the file name and press the [Enter] key.

Note 1: The name can have up to 8 characters long.
It may use any alphabet  or  numeric  on  the  keyboard.  But  you  may  not
use the following punctuation symbols: ( | : " > < ; ! ). You may add an
extension (up to 3 characters) at the end of the file name, for example, .
TXT,  to  distinguish  text  files.  The  file  cannot  begin  to  dot  (.)  Nor  have
more than one dot.

Note 2: If  the  name entered  already  belongs  to  another  file,  the  answer  to  the
following question confirm or not overwriting the file.

2. The focus returns to the file area.

5.3 Closing a File

1. Press [F1] to open the File menu and then select the Close Text option.
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2. The system asks to save or not the text in a file:

a)    NO: The file area is cleaned without store their content in any files.

b)  YES: The following window appears:

Enter the file name and press the [Enter] key.
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Note 1: The name can have up to 8 characters long.
It may use any alphabet  or  numeric  on  the  keyboard.  But

you may not use the following punctuation symbols: ( | : " > < ; !
 ). You may  add an  extension (up  to  3 characters)  at  the  end  of
the file name, for example, .TXT, to distinguish text files. The file
cannot begin to dot (.) Nor have more than one dot.

Note 2: If the name entered already belongs to another file, the answer to
the following question confirm or not overwriting the file.

The saved file is closed, cleaning the file area.

5.4 Editing Files

The file area, allows to edit the contents of a file in the same way as any text editor.
It can navigate in the text by the arrow keys [®] [¬] [] and [¯], using the [Home],

[End], [Page Down] and [Page Up] keys, and delete characters using [Backspace] or
[Del].

Cutting and Pasting Text

It can delete, move and copy text by using the Cut, Copy and Paste functions in the
Edit menu.

Cutting text

1. Place the cursor on the first character of the text to be cut.
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2. Highlight the text to be cut by pressing and holding the [Shift] key while pressing
the [®]. If you highlight text which you do not want to cut, press the [¬] to adjust

the highlight.

3. Press [F2] to open the Edit menu and then select the Cut option. The highlighted
text is cut and the remaining text is reformatted. If a mistake is made, you can
restore the text by immediately selecting Undo in the Edit menu.

Pasting text

1. To paste the cut text to a new location, place the cursor at  the exact spot in the
message where the cut text is to start.

2. Press [F2] to open the Edit menu and then select the Paste option.

3. Repeat steps 1 and 2 as often as you want to paste the text.

Copying and pasting text

It may copy a portion of text and paste it elsewhere.

1.  Select the text to copy (see Cutting text).

2.  Press [F2] to open the Edit menu and then select the Copy option.

3.  Place the cursor at the exact spot in the message where the copied text is to start.

4.  Press [F2] to open the Edit menu and then select the Paste option.

5.  Repeat steps 3 and 4 as often as you want to copy the text.

Cleaning up the communication area

To clear the communication area, press [F1] to open the File menu and then select
the Clear Comm. Memory option.

Undo

To return the editing file to its most recent state, press [F2] to open the Edit  menu
and then select the Undo option. For example, this option would restore text that has
been accidentally deleted or cut.

Select all

To select the entire text of the file  currently  displayed,  press [F2]  to open the Edit
menu and then select the Select all option. This feature can be useful when you want
to combine files.
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Searching text

1.To search for text in a forward or backward direction, press [F2] to open the Edit
menu and then select the Search option. The Search display appears:

2. Type the word(s) to find. Press the [Enter] key.

3. Select  [Forward]  or  [Back]  to  search the  file  in  a  forward  or  backward  direction
respectively from the cursor position. Press the [Enter] key to begin the search.

4. When the unit finds the word, the cursor stops at  the first character of  the word.
Press the [Enter] key to continue the search.

5. To exit from the Search, press [Esc].

Replacing text

1. To replace every occurrence of a word or phrase with another word or phrase in a
file,  press  [F2]  to  open  the  Edit  menu  and  then  select  theReplace  option.  The
Replace display appears:

2. Type the word you want to replace on the Search Text line.

3. Press  the  [Enter]  key  to  select  Replace  by  line.  Type  the  new  word.  Press  the
[Enter] key.

4. Select  [Forward] or [Back] to search the file  in a forward or  backward  direction
respectively from the cursor position.

5. Select whether you want to be queried or not each time the word is found:
Query: Stop at each occurrence of word to answer yes or no to replacement.
All: Replace every occurrence of word without stopping to confirm.

6. Press the [Enter] key to start the replacement.

7. To exit from this screen, press [Esc].

Goto line

1.To  places  the  cursor  at  the  head  of  a  line  desired,  press  [F2]  to  open  the  Edit
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menu and then select the Goto Line option. The following display appears:

2.  Enter a line number and press the [Enter] key. If the value entered is a valid line
number, the cursor shifts to the head of the line selected.

· To go to  the  first  line  of  the  current  file,  press  [F2]  to  open the  Edit  menu and

then select the Goto Top option.

· To go to the last line of the current file, press [F2] to open the Edit menu and then

select the Goto Bottom option.

Changing the current edit area

To switch the current area between the Stand-By display, the communication area
and the file area, press successively the function key [F8] Window.

5.5 Opening Files

1. Press [F1] to open the File menu and then select the Open Text option. A list of
files on the disk appears:

2. Select  a  file,  using  []  and  [¯]  keys.  Press  the  [Enter]  key.  The  contents  file  is

loaded in the file area and the title bar shows the file name.
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· To exit from this option without opening any files, press [Esc].

· To view the contents of a file without load in the file area, select it in the file list

and press the [Spacebar].  To return to the files list, press [Esc].

5.6 Renaming Files

1. Press [F1] to open the File menu and then select the Rename File option.
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2. Pressing the [Enter] key, a list of files on the disk appears:

3. Select the file to rename, using [] and [¯] keys. Press the [Enter] key:
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4. Enter  the New File  Name.  See  file  names conditions in  Saving  a  File.  Press  the
[Enter] key. If the name entered already belongs to another file, the indication "File
name already exists" appears and the renaming is aborted.

5. Repeat steps 2 and 3 to rename another files.

6. To exit from this option, press [Esc].

Creating a file copy

1. Open a file (see Opening Files)

2. Edit the file as necessary.

3.  Save the file (see Saving a File), erasing the original name using the [Backspace]
key, and then entering a new name. Press the [Enter] key.

5.7 Deleting Files

1. Press [F1] to open the File menu and then select the Delete File option.
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2. Pressing the [Enter] key, a list of files on the disk appears:

3. Select the file to delete, using [] and [¯] keys. Press the [Enter] key.
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Select [Yes] to the question (Delete File?)

4. Repeat steps 2 and 3 to delete another files.

5. To exit from this option, press [Esc].

5.8 Formatting Floppy disks

1. Press [F1] to open the File menu and then select the Format Disk option. 

2. Insert a new floppy disk and select [Yes] to the question (Insert new disk. Start?
).

3. The system  shows  the  operation  progress  of  the  disk  format.  Once  completed  it,
will store files in it.
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6 LES Access Code List

Updated at February 2002

Updated at 5 January 2007
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7 Telephone, Telex Country Code Lists
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8 Telex Abbreviations
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Keywords
- A -
Antenna     6

Auto Telex     35

- C -
Calling Reception - Handset     18

Calling Reception - Telex     49

Class 1 stations     2, 6

Class 2 stations     2

Communications Log - Telex     50

Coverage map     2

- D -
Distress - Handset     20

Distress - Telex     47

Distress LES     25

Distress setup     26

DMG     26

- E -
Esc key     7, 32

- F -
Files - Closing     55

Files - Creating     54

Files - Deleting     63

Files - Opening     60

Files - Operations     54

Files - Renaming     61

Files - Saving     54

Files- Editing     57

Formatting Floppy disks     65

Function keys     7, 32

- H -
Handset     6

Handset - Address Book     27

Handset - Calling     13

Handset - Calling Reception     18

Handset - Calling to land subscriber     13

Handset - Communications Log     23

Handset - Display menu     22

Handset - Distress procedure     20

Handset - Main Menu     21

Handset - Menus     21

Handset - MES Calling     13

Handset - Monitor menu     22

Handset - On/Off     10

Handset - Receiving     18

Handset - Setup menu     25

Handset - Stand By     13

Handset - Stations list     27

Handset - Test Distress     28

Handset - Urgent/Safety communications     18

Handset communications     13

Handset components     7

Handset Distress button     7

Hook Off button     7

Hook On button     7

- I -
Inmarsat B System - Characteristics     2

Inmarsat Network     2

- K -
Keyboard     7, 32

- L -
Land Earth Station - LES     67

LCD     7

LES - Land Eart Station     67

LES list     67

- M -
Main Communication Unit     6

Manual Telex     39

MES types     2
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- O -
Ocean Regions     2

On/Off     10

- P -
Priority button     7

- R -
REDIAL     17

Redial button     7

Redialing     17

- S -
Satellites     2

- T -
Telephony     6

Telephony - Country codes     70

Telephony communications     13

Telex - Calling Reception     49

Telex - Communication Area     7, 32

Telex - Communications     32

Telex - Communications Log     50

Telex - Country codes     70

Telex - Distress procedure     47

Telex - File area     7, 32

Telex - Manual communication     39

Telex - Manual communication using commands    
45

Telex - Manual communication using Menus     39

Telex - Message transmission     35

Telex - Receiving     49

Telex - Stand By display     7, 32

Telex - Test Distress     51

Telex - Work areas     7, 32

Telex Abbreviations     79

Telex terminal     6

Telex terminal - On/Off     10

TELEX terminal communications     32

Telex terminal components     7, 32

Test Distress - Handset     28

Test Distress - Telex     51
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